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This document is intended to provide the reader with information related to PRO-CHEX Standard, 

Optional and upgrade features available through PRO-CHEX Enterprise. These features are 

differentiated in this document as follows: 

➢ Standard features will appear in regular font, as shown here. 

➢ Optional features will appear in green, italic font, as shown here. 

➢ Features available with PRO-CHEX Enterprise will appear in blue, bold font, as 
shown here. 

 

If you see a feature within this documentation that is not currently enabled for your organization, contact 

us at [FI INSERT PHONE NUMBER] for assistance. 

 

 

 

 NOTE: 

➢ All screenshots used in this User Guide were obtained while using PRO-CHEX in 

the Chrome browser. If a Client user utilizes PRO-CHEX in a different browser, 

certain screens may display differently than what is seen in this guide because of 

the browser’s particular configuration. However, even though screens may appear 

slightly different, the functionality will remain the same across all browsers.  
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I. WELCOME TO PRO-CHEX! 
 

  

A.  Service Overview 
 

 

PRO-CHEX is a check positive pay service designed to empower account holders (our “Clients”) with the 

ability to prevent financial loss due to check fraud. This guide is intended to provide information to Clients in 

choosing and using the level of protection best suited for their needs. 

 

B.  Introduction to PRO-CHEX 
 
1. The PRO-CHEX service is highly configurable. This guide will outline all PRO-CHEX functionality, but it is 

important to note that some features will only be available if the feature has been enabled by the financial 

institution (FI) and/or the Client user has been granted the appropriate user privilege required to access 

the feature. 

 

2. The table below lists the PRO-CHEX positive pay types available for each account enrolled in PRO-

CHEX, a description of expected behavior and protection level ranking. PRO-CHEX relies on Clients to 

make daily decisions, when required, for the check activity that occurs on their account. When accounts 

are enrolled, a default setting can be established for the system to return or pay a transaction if the user 

fails to do so by the established end-of-day cut-off time. The last column in the table defines the default 

settings available for each type of positive pay service. 

 

Positive Pay 
Type Service Description 

Protection 
Level 

Default Setting 
Options 

Standard 
Positive Pay 

This service requires the Client to provide a list of checks that have 
been issued or voided on an account (Issue Items). The issue items 
for each account must include, at a minimum, a check serial 
number, amount, and status (issued, voided, stopped). The 
financial institution compares each check presented for payment 
(Item) against the list of issue items. If an exception is identified, 
designated Client users are alerted to make a pay or return 
decision. 

Medium Pay or Return 
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Payee Positive 
Pay 

This is an add-on feature to Standard Positive Pay. If this feature is 
utilized, Clients are required to provide the payee name for each 
issue item. The financial institution will compare the name in the 
issue item against the name that appears on the “Pay to the Order 
of” line of the check presented for payment. A scoring method will 
be used to determine the likelihood of a match, and if the score falls 
below the established threshold, the item will be flagged as an 
exception. It is important to note that payee name scoring is subject 
to a lot of variables. Scoring can fail items that should pass if 
Clients fail to perform best practices. Refer to Section VIII. Payee 
Positive Pay Tips & Best Practices for more information. 

High Pay or Return 

Support 
Multiple Payee 

Names 

PRO-CHEX has the ability to accept multiple payee names in an 
issue item file and validate multiple payee names on checks 
presented for payment. Multiple payee names can be placed on a 
single line or multiple lines. 

High Pay or Return 

Reverse 
Positive Pay 

This service does NOT require Clients to provide a list of issued 
items. Clients will need to login every day to view checks presented 
for payment and select the checks they want to return because the 
concept of an exception does not exist since there is no list of issue 
items to compare items against. However, Clients may request the 
financial institution establish a maximum check amount per account 
(Exception Limit). If this optional setting is enabled, an alert will be 
sent to designated Client users ONLY when a check is presented 
that exceeds the maximum amount established. 

Low Pay 

No Positive 
Pay 

This PRO-CHEX Enterprise level service is designed for 
Clients who do not want to participate in any form of check 
positive pay service but would like to obtain access to paid 
check and/or deposit information. 

Low Pay 

Blocked 
Positive Pay 

This PRO-CHEX Enterprise level service, if enabled, means 
accounts are added for fraud protection purposes only. Issue 
items are ignored, and any checks presented on the account 
will be automatically returned. Checks presented on a Blocked 
account will not be presented in cleanup but should be 
available on the Fraud Department report/view. 

High Return 
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3. PRO-CHEX offers alerting (notification) to call designated Client users to action when required. PRO-

CHEX is designed to ensure notifications are relevant, but each Client can advise the financial institution 

of notification levels that best suit their needs. Email alerts are standard. Clients can receive texts alerts if 

the FI has chosen to enable the text alerts feature. 

 

4. The table below outlines a list of events that trigger an alert to a Client, a description of the triggering 

event and if the alert type is Standard or Optional. 

 

 
Alert Type Description 

Standard or 
Optional 

Exception Alert 
Occurs when a check is presented for payment that does not match the 
issue information provided or if an exception limit is set on an account 
enrolled in Reverse Positive Pay. 

Standard 

Issuance File Load 
Alert 

Occurs when an issue file is loaded. The alert contains status 
information to indicate if the issue item loaded properly or if the issue 
item failed due to errors. 

Optional 

Issuance Approval 
Required 

Occurs when issue items are manually entered, or issue files are loaded 
that require a secondary approval. 

Optional 

 

5. When an account is enrolled for PRO-CHEX, one of three levels of notification can be established for 

exception alerts. The notification level options, description and a sample are provided in the table below. 

 

Notification 
Level Description 

Transaction Alerts One alert for each exception identified. 

Account Alerts One alert per account when one or more exceptions are identified. 

Service Alerts One alert per client when one or more exceptions are identified on one or more accounts. 

 

  



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 8 of 159 

 

6. Sample Alerts – Account Level 

 

Via Email: 

 

 

 

Via Text: 
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7. Sample Alerts – Transaction Level 

 

Via Email: 

 

 

Via Text: 
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8. Sample Alerts – Service 

 

Via Email: 

 

 

 

 

 

Via Text: 
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II. PRO-CHEX DASHBOARD BOX 
 

 

A.  Using the Dashboard 
 

1. The Dashboard is the default landing page within the Client portal. If PRO-CHEX is enabled, a PRO-

CHEX box will be displayed. Summary information on current check transactions and status will be 

displayed for accounts the user has been granted access. Active links are embedded within the PRO-

CHEX box to permit users to navigate from the dashboard landing page into the PRO-CHEX service 

module or directly to transactions in the status selected. Dashboard totals are updated in real time as 

transaction status values are changed by a user. 

 

The content displayed in the PRO-CHEX summary box includes the following: 

 

 

 

Service Name In the example provided, clicking PRO-CHEX on the left in the title bar will direct the user 
to the main menu. 

End of Day Cut-Off Time Displayed in the second bar, the time of day indicates when transactions that require 
decisions will no longer be eligible for user decisions.  

Exceptions Clicking on the dollar amount hyperlink on the Exceptions line will direct the user to a 
filtered view of Transaction History that will display only exceptions that require a 
decision. 

 

 



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 12 of 159 

 

 

Set to Pay / Set to Return Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines will 
expand the view to display a breakdown of the total for each category. System Pay or 
Return indicate transactions that will pay or return if no action is taken due to the default 
status. User pay or return indicate a Client user decision has occurred. FI pay or return 
indicate an FI decision has occurred on behalf of the FI. 

 

 

Transaction History The user can click on the dollar amount link for any category to be directed to a filtered 
view of the Transaction History. In the above example, the user has clicked on the dollar 
value of Exceptions on the Dashboard and is directed to a view of exception transactions 
that require decision.  
 
Please refer to Section VI, Subsection A, Transaction History, for more information 
on this function. 
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2. From the Client Dashboard, a user can navigate to the PRO-CHEX Module by clicking Change Module > 

PRO-CHEX. 

 

 

 

 

 

 

 

 

 

B.  Creating Client Users 
 

 

  

 

 

 

A Client User with Admin user privilege can add additional Client users who will then be authorized to use 

PRO-CHEX. 

 

1. From Client Dashboard > Click Manage Users. 

 

 

 

NOTE: 

➢ The Admin user privilege must be enabled. 

➢ This feature is only available if 1) the FI is allowing Clients to manage their own 

users, and 2) it will only display for Client users who have been designated with 

Client Admin status. 
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2. The Client Users page appears. Click the “Create New User” button. 

 

 

 

3. The New User page appears. Fill out all fields available, the click “Create User” button. 

 

 

 

4. If the user is configured for standard security login, the New User interface will display these fields. 
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5. If the user is configured for single sign-on, the New User interface will display these fields. Please note 

that the SSO ID field can have different labels and formats based on the online banking provider being 

used. 

 

 

6. The User profile page appears. Scroll down to the “System Roles” section of the page to select what roles 

should be enabled for the user. For more information on managing user entitlements, please refer to the 

Fraud Prevention HQ Client User Guide, Sections II and III. 

 

 

 

 

 

 

 

 

 

7. Within the PRO-CHEX settings box, the alert method can be chosen. Use the drop-down to select the 

alert method desired. 

 

 

 

 

 

 

 

 

Email Client User will receive PRO-CHEX Alerts via Email only 

Email, SMS/Text Client User will receive PRO-CHEX Alerts via Email and SMS/Text 

SMS/Text Client User will receive PRO-CHEX Alerts via SMS/Text only 
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8. Choose from the list of available accounts enrolled in PRO-CHEX the user is entitled to work with and 

move them to the Selected Accounts box.  

 

> and < move individual accounts between Available and Selected Accounts.  

>> and << move all accounts between Available and Selected Accounts. 

 

 

 

9. For more information regarding Client User Privileges, please refer to Section III. User Accounts and 

Privileges. 
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III. USER ACCOUNTS AND PRIVILEGES 
 

 

 

 

 

  

Defined in this Section are Client user privileges and alerting methods supported for the PRO-CHEX 

module.  

 

 

 

A.  User Privilege Dependencies 
 

Some user privileges are standard, and some are dependent upon features that are enabled by your financial 

institution. If you see a privilege below and it does not appear in the Client user interface, the feature has not 

been enabled.  

 

Privilege User Feature Dependencies 

Approve Issue File Client FI Enabled 

Issue Item Status Report Client FI Enabled 

Delete Issue File Client FI Enabled 

Issue Templates Client FI Enabled 

Issue Warehouse Client Standard 

Transaction History Client Standard 

Scheduled Reports Client FI Enabled 

Load Issue File Client Standard 

Additional information about creating and editing Client users can be found in the  

Fraud Prevention HQ User Guide, Sections II and III. 
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Privilege User Feature Dependencies 

Item Lookup Client Standard 

Change Transaction Status Client Standard 

View Issue File Status Client Standard 

Issue Load Alerts Client FI Enabled 

Manual Issue Entry Client Standard 

Reconcile Accounts Client FI Enabled 

 

B.  Client User Privileges 
 

 

 

  

1. On the Client User page, scroll to PRO-CHEX service station. 

 

2. Choose from the list of available accounts enrolled in PRO-CHEX the user is entitled to work with and 

move them to the Selected Accounts box. 

 

> and < move individual accounts between Available and Selected Accounts.  

>> and << move all accounts between Available and Selected Accounts. 

NOTE: 

➢ The Admin user privilege must be enabled. 
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3. Selecting PRO-CHEX Client User Privileges 

 

a. Selecting all | none 

 

i. By selecting all, the user will be assigned all user privileges. 

 

 

 

ii. By selecting none, previously assigned user privileges will be removed.  

 

 

 

 

 

  



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 20 of 159 

 

iii. Clicking in the box beside each user privilege will add or remove the checkmark from the box. 

Adding a checkmark will give the user that privilege, removing the checkmark will remove the 

privilege from the user. 

 

 

 

Approve Issue File Allows the user to approve issue files loaded by 
other users when a client is configured for 
issuance dual approval. 

 NOTE: Approve/Reject Files must be enabled. 

 
Transaction History 

 
Allows the user to view check transactions that have 
been presented for payment. If this privilege is 
enabled, the user will also have access to an item 
lookup sub-menu option. 

 
Scheduled Reports 

 
Allows the user to download pre-defined, pre-
scheduled reports. 

 NOTE: Scheduled Reports must be enabled. 

 
Reconcile Accounts 

 
Currently, Account Reconcilement is performed 
only by the FI. This user privilege for a client 
user, however, is necessary for the client user to 
access Reconciliation reports or to view past 
and present Reconciliation Period activity. 

 NOTE: Scheduled Reports must be enabled. 

 
Load Issue File 

 
Allows the user to load issue files via the Client 
Portal. 

 

 

 

Item Lookup Ability to look up all recorded data on individual 
issued items. 

Change Transaction 
Status 

Requires Transaction History user privilege. 
Allows a user to change the status of a transaction 
from return to pay or pay to return. 

View Issue File Status Allows the User to view the status and detail of all 
issue (files) loaded or manually entered into the 
system. 

Issue Load Alerts Will receive success or failure alerts when users 
load issue files. 

 NOTE: Issue Load Alerts must be enabled. 

 
Manual Issue Entry 

 
Allows the user to manually create an issue item. 

 NOTE: Issue Load Alerts must be enabled. 
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Issue Item Status Report Allows the user to view issued items by status for a 
specific date or date range. 

 NOTE: Issue Item Status Report must be enabled. 

 
Delete Issue File 

 
Requires View Issue File Status privilege. Allows a 
client user to delete an issue file that was previously 
loaded if no issue items in the file have been used in 
matching. 

 NOTE: Delete Issue File must be enabled. 

 
Issue Templates 

 
Allows a user to create a template that defines the 
format of the issue file they will load and the format 
and location for the data elements that will be 
provided in the file. If this privilege is enabled for a 
user, the user will also be able to manage additional 
issue fields. 

 NOTE: Issue File Mapping must be enabled. 

 
Issue Warehouse 

 
Allows the user to view files loaded into the system. 

  NOTE: Issue Load Alerts must be enabled. 

 

 

 

4. Select Save User. 

 

a. Success message appears. 
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IV. MANAGING ISSUE ITEMS 
 

 

 

Certain types of positive pay services require Clients to maintain a list of issued items for the financial 

institution to compare presented items against so exceptions can be identified. 

While issue items can be added after a check has been presented for payment, it is highly recommended 

that Clients enter or load issue items prior to disbursing paper checks to payees, as failure to do so could 

result in denial of payment if the check is presented at the teller line for deposit or to be cashed. 

If issue items are entered or loaded on accounts configured for positive pay types that do not require a list, 

PRO-CHEX will ignore them.  

When an issued item is entered or loaded into PRO-CHEX, the status and disposition of the issued item is 

tracked. The table below describes the status and disposition labels associated with issue item 

management. 

 

Labels Description 

Issued A status defined by the Client that indicates a check was issued. 

Voided A status defined by a Client that a check was issued but later voided and not distributed. 

Stopped A status defined by a Client or designated by the FI if the FI chooses to control this status. 

Available for Matching 
A status assigned by the PRO-CHEX system when an issue item is entered or loaded by a 
Client. 

Used in Matching 
A status assigned by the PRO-CHEX system when a check is presented for payment with a 
serial number that matches a serial number for an issued item. 

Outstanding 
A status displayed in the issue warehouse that indicates a check has not yet been presented 
for the issued item and it is still available for matching. 

Paid 
A status displayed in the issue warehouse that indicates a check has been presented against 
an issue item and it was paid by the system, Client user or FI. 

Returned 
A status displayed in the issue warehouse that indicates a check has been presented against 
an issue item and it was returned by the system, Client user or FI. 
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Purged 
A status assigned by the PRO-CHEX system when an issue item that has not been used in 
Matching (outstanding) has been removed from the system. The purge period is defined by 
the financial institution.  

Deleted 
A status value displayed in Issue File Status that indicates that a file that was loaded was 
deleted by a Client or FI user. A history of the file load and delete action are retained but the 
issue items are removed as if they were never introduced to the system. 

Updated 
If an issue item is updated after it was loaded, history will be available in the issue item 
warehouse when the drop-down for an issue item is expanded. 

 

 

 

A.  Test Mode 
 

Clients can request the FI enroll accounts with an inactive status and grant users’ access to the system to 

test issue file load. Issue items loaded while in test mode are marked as test issue items and will not be 

displayed in the issue warehouse or used for matching against presented checks. Clients must notify the FI 

when testing has been completed and they wish the account to be active. 
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B.  Status Values 
 

Issued items can have a status of Issued, Voided or Stopped. 

 

1. Issued:  The check has been issued and distributed for payment. 

 

2. Voided: The check has been voided by the maker. A check is usually voided prior to disbursement. A 

voided check cannot be used to make a payment or withdraw money from the account. 

 

3. Stopped: A check that has a stop payment placed on it. A stop payment is placed by a financial institution 

to cancel a check that has not yet been processed.  

 

4. Disable Stop Payments: The FI may choose to Disable Stop Payments in their configuration settings. The 

FI may choose to do this because they prefer to update those items in their core banking system. 

 

If stop payments are enabled, the client user can: 

 

➢ Load issue files with stopped status items 

➢ Overwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided 

➢ Change a previously Stopped item to Issued or Voided via Issue Warehouse 

If stop payments are disabled, the client cannot: 

➢ Load issue files with stopped status items 

➢ Overwrite via Manual Issue Entry to change an item from Stopped to Issued or Voided 

➢ Change a previously Stopped item to Issued or Voided via Issue Warehouse. 
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C.  Manual Entry 
 

 

 

 

 

 

 

If the FI enables this feature, Clients can manually enter a list of checks that have been issued. To manually 

enter an issue item, the user must be granted the manual issue entry user privilege. 

The table below describes a list of fields that may be displayed in the manual entry screen, the criteria for the 

field to display and how the information entered will be used to identify exceptions when matching issue items 

to checks presented for payment. 

 

Field Criteria Use 

Serial # The check number/serial # is always required. To identify if the check was 
issued or presented more than 
once. 

Amount A dollar value is always required. Used to identify if the amount of a 
check has been altered. 

Payee 
Name 

The person(s) or entities to whom the check was intended to pay. The 
field will support entry of multiple payee names (maximum of 4 
allowed) by clicking “Enter” to input another name on the next line. 

This feature is optional, and the field will only appear for accounts 
configured for payee positive pay.  

Used to identify if the name in the 
“Pay to the order of” line has been 
altered. 

Status 

Each check should be accounted for, even checks that have been 
voided or have had a stop payment issued. The status value advises 
the FI if a check has been issued and distributed, issued, later voided 
and not distributed or issued, distributed and stop payment order was 
requested later. The issued and void status values will always be 
available for selection. The stopped status will only appear if the FI has 
enabled this option for Client designation. 

Used to determine if a check 
should be analyzed for matching 
(issued) or if a check was 
presented for payment that was 
previously voided or stopped. 

Issuance 
Date 

A date the check was issued and valid for payment is always required. 
The issuance date will always default to the current date, but the user 
can assign a back or future date. 

Used to determine if a check is 
presented earlier than intended or 
later than allowed. 

Additional 
Issue 
Fields 

Only available if the Issue Templates user privilege is turned on for a 
user. Additional issue fields are typically used if a Client requires PRO-
CHEX to retain information related to the issued item for reconciliation 
purposes. 

Used for account reconciliation 
purposes.  Example:  An invoice # 
associated with a check. 

NOTE: 

➢ The Manual Issue File user privilege must be enabled. 

➢ PRO-CHEX will not accept issued items with a date more than two years in the 

past. 
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1. From the PRO-CHEX module, click Perform > Manual Issue Entry. 

 

 

 

 

 

 

 

 

 

2. The Manual Issue File Entry screen appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Account Select appropriate Account Number from the drop-down menu. 

Auto populate next 
check number 

When checked, the next check number will auto-populate in the following row. This feature is 
designed to eliminate serial number entry when checks are issued in sequential order. 
 
When unchecked, the next check number will remain blank until it is filled in by the user. 

Row Each issue item will be numbered in the order they are entered. Once the cursor is placed in the 
current row, an additional row will appear for the next entry. 

Serial Number Type the item serial number for this manual issuance file in the Serial Number field. 

Amount Type the dollar amount for this manual issuance file in the Amount field. Or use the up and 
down arrows in the Amount field to select a dollar amount. 

Payee Name Type the payee name for this manual issuance file in the Payee Name field. The Payee Name 
field supports the entry of a single payee, or multiple payees. 
 
Please see Step #3 below for in-depth information about the Payee Name field and 
Multiple Payee Names. 
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Status Issued The check has been issued. 

Voided The check has been voided by the maker. 

Stopped The check has had a stop payment placed on it. 

It is important to note that if the FI has disabled stop payments, the Stopped status 
option will not appear in the drop-down menu. 
 

Issuance Date Click on the Issuance Date field and select a date from the calendar that this item was issued. 

 

 

 

3. Payee Names: The Payee Name field supports up to four Payees. 

 

a. Click within the Payee name field to enter Payee Name(s). 

 

 

 

b. The view size on the Payee Name field can be enlarged by dragging bottom right corner of field box. 

The feature may not be available based upon the browser used. 

 

 

 

 

 

 

 

 

c. Input the Payee Name in the field. If there are multiple payees, an Enter (carriage return) must be 

used to input a second, third or fourth payee on separate lines in the field for it to be distinguished as 

different payees.  
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If multiple payees are listed on a single line of the check, putting them on separate lines is not 

applicable. 

 

 

 

d. The Payee Name field currently supports 500 characters in total. This count will include the carriage 

returns separating multiple payees. The 500-character limit is for the entire field, and not per payee.  

 

It is important to note that although 500 characters are allowed in this field, names might be 

truncated if using a fixed width template and the number of characters allowed in that column 

are less than 500. 

 

 

4. To edit any row, click in the fields to be edited and make changes. 

 

 

5. When all manual issuance files have been entered, click Save button. 
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6. The Manual Issuance File Status detail page appears. 

 

 

Account Number The account number on each issue item. 

Serial Number The serial number of the issue item. 

Amount The amount of the issue item. 

Payee Name Name of the payee(s) from the issue item. 

Status Available_For_Matching The issued item is available for exception matching against an 
incoming check. 

Duplicate Issuance This issued item is a duplicate and has already been issued. 

Used in Matching This issued item has been used in the exception matching 
against an incoming check. 

Load Date Date and time the file was loaded. 

Issuance Date Date the item was issued. 
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7. Click the Back to Status button to view the Issuance File Status page. For more information, please 

refer to Subsection G, Issue File Status. 

 

8. Issuance Dual Approval: 

 

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the FI. In this 

circumstance, manual entry files must be approved by a second client user or, if no second user is 

available to approve the file, the client can request the FI approve the issue file.  

 

Please refer to Subsection H. Issuance Dual Approval for more information about the Dual 

Approval process. 

 

9. Disable Stop Payments: When the FI has disabled stop payments, client users cannot create new 

stopped issue items or modify previously stopped issue items. The FI can, however, feed stop pay items 

from the core banking system. 

 

a. If a user attempts to create a manual entry item with a serial number the FI has loaded a stop pay on, 

the system will not accept the item. 
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D.  Issue Templates 
 

 

The purpose of issue templates is to make it easy to load issue items into PRO-CHEX using files that can be 

generated out of most accounting systems. PRO-CHEX provides organizations a variety of flexible options for 

providing a list of checks that have been issued or voided. 

 

Issue templates allow users to select from a list of file formats supported and identify where the required data 

elements are located within the file. 

 

Once a template has been set up, the template can be selected when loading a file to tell PRO-CHEX how to 

utilize the data contained in the file. 

 

Multiple file templates can be set up, displayed and used. FI’s can create templates for Clients to use or the 

FI may choose to allow Clients to create their own templates. 

 

 

 

 

 

 

 

 

1. From within the PRO-CHEX module, click Manage > Issue Templates. 

 

 

 

 

 

 

 

 

 

  

NOTE: 

➢ The Issue Template user privilege must be enabled. 
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A screen will appear that lists any existing templates that are available for view or edit, and a button to 

Create New Template. NOTE: Templates created by the FI cannot be modified by a Client. Templates 

created by the Client can be modified by the Client and the FI. Templates created by the FI can be 

viewed by clicking the eye icon in the Edit/View column. 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 

2. To view or edit an existing template, click the pencil icon for the appropriate template.  

 

3. To delete an existing template, click the checkbox next to the Templates to be deleted and click Delete 

Selected. Templates that have the Delete option were built by the Client and can be deleted/edited by 

the Client user. Templates without the Delete option were built by the FI and cannot be deleted/edited by 

the Client user. 

 

4. To create a new template, click the Create New Template button. 

 

 

  

  

  

  

  

  

  

  

  

 

The upper portion of the template screen will not change, regardless of the file type selected. The template 

name, file type and template status values are required. The header and footer fields are optional.  

 

Many accounting systems can export excel or fixed width files. Sometimes those files have header 

(beginning) rows or footer (ending) rows that contain data that is not required by PRO-CHEX. 
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When setting up a template, the Client can define the number of rows PRO-CHEX should ignore at the 

beginning and end of the file. It is important to note that if the values are entered incorrectly, an issue file 

may load with errors or no items. 

 

 

 

 

 

  

About Multi-Line Payee Name Separator: 

 

The Multi-Line Payee Name Separator field is optional. This feature allows the FI to enter a 

character that can be used to separate Multiple Payee Names that are on separate lines of an 

issued check. 

Currently, the system restricts the allowed characters to the following:  ;  |  ,  -  _  / . The user 

must be aware that using a separator character that appears elsewhere in the payee name or might 

conflict with the file itself can cause issues. Examples of scenarios where problems might arise are 

listed below. 

Within a Comma Separated file (.csv), different data fields are separated by a comma. Therefore, a 

comma cannot be used in the data field itself, or the .csv will read the comma as a separator before 

the next field. Therefore, listing two payees for an item in this way: “Elain Archeron,Nesta Archeron” 

will cause issues reading the .csv file. In this scenario, the user should select a multi-line payee name 

separator character that will not cause an issue, such as a semicolon. “Elain Archeron;Nesta 

Archeron” in the Payee Name field of the .csv file will process correctly. 

 

If the user selects a separator character that would ever appear in a payee name field, such as a dash 

(-), the system would then separate the data before and after the character as separate payees. For 

instance, if the user has selected a dash (-) as the Multi-Line Payee Name Separator, and a common 

payee used is “In-and-Out Burger”, the system will flag this as having multiple payees. In this case, the 

user should select a multi-line payee name separator that will not cause such issues, such as a pipe 

(|) or a semicolon for cases of multiple payee names. 

 

Please refer to Section VIII Payee Positive Pay Tips & Best Practices for more information 

about multiple payee name handling. 
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The mapping section below will display based on the file type selected. It is important to note that not all 

fields/options seen in these graphics may be available for your organization based on settings 

configured by your financial institution. 

Excel and separated files will require Clients to define the column data elements that will be found.  
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Fixed Width files will require the Client to define the start and end position in which the data element 

is located. 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 

The mapping section on the lower part of the screen displays the required fields. The Check Serial 

# and Amount fields are always required. The Client must specify if the amount data in the file to be 

imported will or will not contain decimal points. For example, if the Amount value is set to Fractional 

Dollars, then 100, 100.0 and 100.00 are all processed the same. If the Amount value is set to 

Whole numbers of cents, the system will divide by 100 and save it as a dollar value. For example, a 

value of 100 would be saved as $1.00 in the system. 

The Client may choose to import additional data by checking the Add box next to the desired data element. 



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 36 of 159 

 

If the Status box is not checked (as shown below), PRO-CHEX will load all issue items with a status of 

Issued. If the Client file represents Voided items as a negative number, the Client can check the box Treat 

Negative Amount as Void and PRO-CHEX will status any item in the file with a negative value as Voided. 

Issuance with a $0 amount will also be treated as void. 
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If the Client checks the Status box additional fields will display as shown below. If the Client’s accounting 

system exports issue items with an Issued and Voided status, no additional action is required. 

 

 

It is important to note that if the Status box is checked for a template, and this information is not provided in 

the issue file loaded, the system will give each record an ISSUED status. In addition, the STOPPED status 

may not appear in the Template configuration screen if the FI has disabled stop payments. 

If the accounting system used exports issued items with a value of X and voided items with a value of Y, 

the user can identify the values as shown below so PRO-CHEX can translate the data appropriately when 

importing the data. 
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A description has been provided below to define system behavior if additional data elements are included. 

 

Account # If the account box is selected, the user can import one file that contains issue items for 
multiple accounts. If the account box is NOT selected, when a Client user loads a file through 
the Client portal, PRO-CHEX will require the user to select the account the checks were issued 
on. 

Issuance Date If the issuance date box is NOT checked, PRO-CHEX will default the issue date to date the file 
was loaded. If the issuance date box is checked, the file must contain an issuance date for each 
item. For Excel files, PRO-CHEX will translate the data format used in the file. For separated and 
fixed width files, the Client must define the date format being used as shown in the screenshot 
below. It is important to note that the formats displayed are examples only, a complete list of date 
formats can be found at: 
 

https://docs.oracle.com/javase/8/docs/api/java/time/format/DateTimeFormatter.html#patterns 
 
 
 

 

 

Payee Name The Payee Name box will only appear if one or more accounts are configured for payee positive 
pay. If the payee name box is checked, PRO-CHEX will require the payee name for accounts 
configured for payee positive pay. If payee name is provided for accounts not enrolled in payee 
positive pay, the payee name data will be ignored when the file is loaded. For Excel or delimited 
files, the complete and single payee name is expected in a single column. For fixed width files, 
the complete and single payee name must be contained in the file between the starting and 
ending position. 
 
If Multiple Payee Names feature is enabled, the Issuance Payee name may display more 
than one payee. 

 

  

https://docs.oracle.com/javase/8/docs/api/java/time/format/DateTimeFormatter.html#patterns
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E.  Additional Issue Fields Information 
 

Additional Issue Fields are only available if the Issue Templates user privilege is turned on for a user. 

Additional issue fields are not used in any exception matching process. These additional issue fields 

are available for Client use to allow Clients to record additional information into an issuance file to be used 

for historical or reconciliation purposes. If this feature is enabled and in use, it will impact the view and 

behavior of the Manual Issue Entry and Issue File Template screens. A few examples are shown below. 
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PRO-CHEX offers the option of creating up to 6 additional issue fields within an issue template.  

 

 

Additional issue fields 1 and 2 are reserved for use by the FI to set institution-wide additional issue fields that 

can be accessed by all enrolled clients. 

 

Additional issue fields 3 through 6 are available for Client-specific use and can be tailored to fit the 

recordkeeping needs of the individual Client. These fields can be configured by the FI at Client’s request, or 

by the Client user. 

 

Additional issue fields, once set up for client use, will be displayed as configuration options in any File 

Templates that are created or edited. In turn, once enabled, these additional issue fields will be displayed 

when viewing file status or transaction status on any issued items. 

 

1. From within the PRO-CHEX module, click Manage > Additional Issue Fields. 
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2. The Additional Issue Fields page appears. 

3.  

  

  

.   

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 

Issue Field FI Global 1 and FI Global 2 are reserved for FI labels. Client-1 to Client-4 may be used by the FI 
or clients and are customizable to the Client. Select the Additional Issue Field desired by 
clicking the drop-down menu. 

Label The name of the additional issue field the Client wishes to set up. The label must be unique to 
the client, and the client labels may not match any labels already configured by the FI. 

 

3. Once a Client clicks the drop-down menu to select an Additional Issue Field, another row will appear so 

that further Additional Issue Fields can be added, until all 4 available Additional Issue Fields have been 

setup. 

 

4. Once all Additional Issue Fields have been created, click Save button to complete the process. 

 

5. Any existing Additional Issue Fields can be edited by clicking on the Additional Issue Field drop-down or 

by clicking within the Label field. 

 

6. Any existing Additional Issue Fields can be deleted by clicking the Trash icon in the Delete column on the 

Additional Issue Fields page. 
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7. Once Additional Issue Fields are established, they will be displayed within the Client’s File Templates, 

both existing and new, as a field that can be mapped when submitting Issuance File data. The user 

should see the additional issue fields that were set up at the bottom of the list. 

 

8. The Additional Issue Fields will be displayed when Client submits files via Issuance Manual Entry and are 

also displayed when viewing items in the Issue Warehouse. 

 

F.  Loading Issue Files 
 

 

 

  

  

  

  

  

 

 

 

 

 

 

PRO-CHEX allows Client users to load issue files into the system for use in matching. PRO-CHEX accepts 

these files in a variety of formats, used in conjunction with file templates (covered in the previous subsection).  

 

 

1. From the Client Portal: 

 

a. PRO-CHEX module, click Perform > Issue File Load. 

 

 

 

 

 

 

 

 

NOTE: 

➢ The Load Issuance File user privilege must be enabled. 

➢ PRO-CHEX will not accept issued items with a date more than two years in the 

past. 

➢ If Multiple Payee Names feature is enabled, PRO-CHEX will support more than one 

payee name in the Payee Name field of issuance files. Please see Step #2 below for 

more information. 

➢ Issue file loading will strip and ignore dollar signs on dollar amounts, and double 

and single quotations around data fields. 



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 43 of 159 

 

b. The Load Check Issuance File page appears. 

 

 

c. Select the Template drop-down box to select from a list of existing templates. Select one of the 

available templates listed. If only one template is available for a client, the drop-down box will select 

that template by default. 

 

 

 

d. If the template selected was created without the Account field enabled, then a drop-down box will 

display so that an Account can be selected. Select from the list of accounts. If only one account is 

available for a client, the drop-down box will select that account by default. 
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e. The file upload interface will appear. Click the Browse button to select the appropriate file. 
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f. Once the file is selected, it will be displayed in the upload interface.  

 

 

 

Remove The file will be removed from the page. 

Browse Use Browse to locate the file you want to load. 

Upload The file will be uploaded. 

 

 

 

g. The Status Bar will display the current status of the file. 
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h. If errors were encountered during the initial processing of the issuance file, the Parse Errors display 

will appear, allowing the user to view the error detail within the file. The most common reason this 

error would appear is because the file contains improper formatting. At this point, the user will have 

the option to: 

 

➢ Correct those errors. 

 

➢ Delete individual errors. This feature only displays if there are errors in the file and is only 

available until errors have been corrected and the file is saved. 

 

➢ Delete all errors. This feature only displays if there are errors in the file and is only available until 

errors have been corrected and the file is saved. 

 

o This will retain the totals and counts for audit history. 

 

➢ Discard the file. This feature shows up when there is an error in the file. This option is not 

available after corrections have been made and saved. 

 

This will remove the file and its contents from the system. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this case, the account numbers in the issuance file were entered incorrectly and they need to be 

corrected before the file can be fully processed and loaded. 
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i. Click on any of the fields highlighted in red to make updates or changes. 

 

 

In this example, the user is presented with an account number drop-down so they can choose the 

correct account number for the issuance item. 

 

 

j. Once all errors have been corrected, the red highlights are no longer visible, and the file can be 

reprocessed by clicking the Save and Submit button. This feature is only available until all errors are 

corrected, deleted, or discarded. 
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k. The file will be returned to processing. 

 

 

 

 

 

 

 

 

 

l. If the file processes successfully, the user will be able to view the details on all the items in the file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If there are no errors in the file during the initial load, then the file will automatically display as 

approved and complete. 
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If an issuance file needs to be deleted for any reason, the user can click on the Delete button and the file will 

be removed. Deleting a file will retain item counts and totals as audit history. NOTE: Files are only eligible 

for deletion if every item in the file is still in an available for matching status. If just one item in the file 

has been paid, the file cannot be deleted. 

 

 

2. Multiple Payees:  

 

PRO-CHEX has the ability to support customers with multiple payee names on issued items. The system 

can score multiple names on a check against information provided in the issuance file.  

 

a. When the Client user loads issue files into the system, the loaded file is processed with the Issue 

Template set up within PRO-CHEX. The Issue Template allows for selection of a Multi-Line Payee 

Separator, a character chosen to separate the names of multiple payees in the issue file. 

 

b. If multiple payees are listed on a single line of a check, no action needs to be taken. 

 

c. If multiple payees are listed on two or more separate lines on a check, the multiple payee separator 

character (which should match the one designated in the template), must be used between each 

name. In the example below, the Multi-Line Payee Name Separator designated in the Issue Template 

is a pipe (|). The issue items shown are entered with the pipe separator between each name, with no 

spaces.  

 

 

When the issue file is loaded, the system would then separate the data before and after the character 

as separate payees. 

 

Please refer to Subsection D of this Section, Issue Templates, for more information about 

Multi-Line Payee Name Separators and how best to utilize this feature. 
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3. Direct Send Issue Files: 

 

If supported by the FI, this feature allows the client to send their issue files to their financial institution via 

SFTP or another file transfer method so that the FI can load those issue files to PRO-CHEX for 

processing. It is important to note the following guidelines: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Issuance Dual Approval: 

 

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the FI. In this 

circumstance, loaded issue files must be approved by a second client user or, if no second user is 

available to approve the file, the client can request the FI approve the issue file.  

 

Please refer to Subsection H. Issuance Dual Approval for more information about the Dual 

Approval process. 

 

  

NOTE: 

➢ Only one template type can be selected for use by a Client. 

➢ The account number must be included in the issue template assigned. 

➢ The template must have mapping set up to accommodate all account configurations. If 

one account is set for payee positive pay and one account is set for standard positive 

pay, then the payee name should be mapped in the template; however, it is not required 

for accounts enrolled in Standard. 

o In the example below, there is an issue item for two accounts, each configured 

differently. Account 12121212 is set for standard positive pay and 12345678 is 

set for payee. The file loads without incident if no payee is included for the 

standard positive pay account (even though the issue template defines the 

position/location) because PRO-CHEX knows the payee name is not required 

for account 12121212. However, if the payee name is not provided for account 

12345678, the file will fail.  
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5. Disable Stop Payments: When the FI has disabled stop payments, client users cannot create new 

stopped issue items or modify previously stopped issue items. The FI can, however, feed stop pay items 

from the core banking system. 

 

a. If a user attempts to load an issue file with serial numbers the FI has loaded a stop pay on, the 

system will not accept the file. 
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G. Issue File Status 
6.  

 

The purpose of the Issue File Status feature is to provide Client users the ability to view and/or manage issue 

files loaded or manually entered by the client. The disposition or status of the file is available. Authorized 

client users can also manage these files as outlined in the next section. 

 

1. View Issue File Status 

 

 

 

 

 

 

 

 

a. Within the PRO-CHEX module, click View > Issue File Status. 

 

 

 

 

 

 

 

  

NOTE: 

➢ The View Issuance File Status user privilege must be enabled. 
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b. The Issuance Files Status page appears. 

 

 

c. To filter the date range of files shown, click on the Date Range drop-down. 
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d. To narrow the search results, click Filters and a window containing additional search criteria will 

appear. 

 

 

Issuance Load ID The ID number associated with the specific file. 

Status Client_Approved The file was approved by the client. 

Client_Discarded Client discarded means a client user decided to discard the issue file 
before it was fully processed into the database. 

Deleted A deleted file has been processed into the system but was removed by 
an FI or Client user. The file information will still be in the system and 
can be found in the Issue warehouse. 

Edit_Pending A file in this status was loaded with errors. Before the file can be 
processed into the database and be displayed in the issue warehouse 
or be used in matching, the errors will need to be cleaned up or 
removed from the file. 

Failed The file failed to load. 

FI_Approved The file was approved by the FI. 

Ineligible_Items The file contains ineligible items and the load did not complete 
successfully. Ineligible items will need to be removed and the file 
reloaded. 

Loading The file is loading. 

Processing The file is processing. 

Queued The file is in line awaiting a status change. 

Suspended The file has been suspended.  
 
“Suspended” status can be related to the Issuance Dual Approval 
feature. Please refer to Subsection H. Issuance Dual Approval, for 
more information about this feature. 
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System_Approved The system is set to default approve the file. 

System_Discarded Discarded files are files that a client user loaded to PRO-CHEX and 
had errors that need to be cleaned up. If the errors are not cleaned up 
by deadline displayed under the progress bar, which is three days, the 
file will be automatically discarded by the system and no record of it will 
be kept. 

Test_Approved In test mode a client user is able to load issue files to make sure that 
the issue template that was created and the file loaded to the system 
correctly. This function informs the user if the file will process in the 
regular user interface, but items are not available for matching in test 
mode. 

Min Amount The minimum dollar amount of the entire file. 

Max Amount The maximum dollar amount of the entire file. 

 

 

 

e. Once search criteria are selected, click Apply to narrow your search results. 
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f. Search results are displayed in pages of 25 items. If the search contains more than 25 issue files, the 

results will be displayed on multiple pages. Use the navigation buttons at the top of the search results 

to review all results. 

 

 

  

  

  

  

  

  

  

 

 

 

 

 

 

 

Issuance Load ID The ID number assigned by PRO-CHEX when a file is loaded. Their value only 
comes into play if the FI needs to contact ACH Alert regarding an issuance file 
loading problem they cannot troubleshoot themselves. These pieces of 
information should be provided in any helpdesk ticket opened. 

File Name The file name assigned by the Client at load time. If the transactions were 
manually entered the file name will appear with a prefix of MANUAL followed by a 
system generated number sequence for ease of differentiation. 

 

 

 

 

 

 

Status Please see #4 in this section for a list of possible Status codes. 

Load Date/Time The date and time this file was loaded. 
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Transaction Count The number of transactions contained within the file. 

Transaction Total The total dollar amount of the transaction. 

View Displays View button if a file has no errors or is ineligible to be edited. It is 
important to note that authorized FI users can click View to get to the Delete 
button to delete a file. See below for more information. 

Manage Displays Manage button if the file contains errors that can be edited. See below 
for more information. 

 

 

2. Click the arrow (>) next to the Client Code to view more useful detail on each issuance file.  

 

 

File ID The ID number assigned by PRO-CHEX once an issuance file is processed and 
committed to the database. If an Issuance Load ID is present but a File ID is 
not, the file was received but did not load properly or has not been processed 
all the way to the database. The File ID is useful when contacting ACH Alert 
Help Desk about a problem with a file. 

Status Message Displays error messages or indicates if an issue file has been deleted. 
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3. Click View button to view the individual issue files. The [File Name] page appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

  

 

File Status Bar Displays progress of issue file. This feature automatically refreshes and keeps the user 
informed on the status of the file as it goes from Queued to Approved or Failed. 

Account Number The Account Number of each item within the file. 

Serial Number The serial number of each item within the file. 

Amount The dollar amount of each item within the file. 

Payee Name If Applicable, the name of the payee of each item within the file. 

Status Available for Matching Items marked as Available for Matching are issue items that 
have loaded to the system but have not been matched to a 
presented item. 

Used in Matching Items marked as Used in Matching are issue items that a 
presented item has been matched to. 

New Issuance Item This status will only display in a file that was not loaded to 
the database for processing. 

Ineligible for Modification Items ineligible for modification are items that have been 
matched to presented items and are either in a current 
status of paid or returned and can therefore no longer be 
modified. 

Duplicate Issuance Duplicate issuance items are issue items that duplicate 
previously loaded issue items exactly. 

Load Date The date and time loaded of each item within the file. 

Issuance Date The date of the issued item. 
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4. Manage Issue File Status 

 

 

 

 

 

 

 

 

 

 

a. Click Manage button to edit errors within an issue file. The [File Name] page appears. 

 

i. Correct Items. 

 

1) Fields highlighted in red have an error and are blocking the issue file from loading all the way 

to the system.  

 

2) When a highlighted field is clicked the user can either select the correct data from a dropdown 

or enter it in directly in the field. 

 

3) Once all errors have been corrected, the user can click Save and Submit at the bottom, so the 

file is reprocessed. 

 

 

 

  

NOTE: 

➢ The Load Issuance File user privilege must be enabled. 

➢ The View Issuance File Status user privilege must be enabled. 

➢ The Delete Issue File Status user privilege must be enabled. 

➢ The Manual Issue Entry user privilege must be enabled. 
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ii. Delete Items 

 

1) Individual items can be deleted from the errors screen if the option is available.  

 

2) The user would click the trashcan in the Delete column to delete any individual items.  

 

3) Once items have been deleted, the user can click Save and Submit at the bottom, so the file 

is reprocessed.  

 

a) The user can also click Delete All Errors at the top of the delete column. 

 

4) This will allow the rest of the file to process into the system.  
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iii. Discard a File 

 

1) An entire issue file can also be discarded. 

 

a) The user can click the discard button at the bottom of the screen. 

 

b) Another option is to allow the system to discard the file automatically after three (3) 

business days.  

 

In both instances, the system will act as if the file never existed and any issue information 

from the file will not appear in any reporting or view.  
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iv. Delete a File 

 

1) Users are also able to delete an issue file if none of the items in the file have been used in 

matching by clicking on the delete button.  

 

a) When a file is deleted the items will appear in issue views and reporting.  

 

 

5. Issuance Dual Approval: 

 

Some clients may have the optional Issuance Dual Approval feature enabled, if offered by the FI. In this 

circumstance, manual issue entry files or loaded issue files must be approved by a second client user or, 

if no second user is available to approve the file, the client can request the FI approve the issue file.  

 

Please refer to Subsection H. Issuance Dual Approval for more information about the Dual 

Approval process. 
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H. Issuance Dual Approval 
6.  

 

PRO-CHEX Enterprise offers the ability to support dual approval for issuance file loads. If enabled by the FI 

and configured for a client, any manual issue entry files or issue files loaded by the client will be held in 

“suspended” status until approved or rejected by a secondary user.  

 

 

 

 

 

 

 

 

1. If a Client User has manually entered issue items or loaded an issue file requiring dual approval, another 

client user must approve the issue file or manual entry file. 

 

2. Within the PRO-CHEX module, click View > Issue File Status. 

 

 

 

 

 

 

 

 

 

3. The Issuance Files Status page appears. Files requiring dual approval will show a status of “Suspended”. 

Click the Manage button to review the file. 

 

 

 

 

 

 

 

 

 

 

 

  

NOTE: 

➢ Approve/Reject Issue Files permission must be enabled by the FI. 

➢ The Approve Issue File user privilege must be enabled. 
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4. The Issue File review page displays a File Status box at the top of the screen which outlines the current 

status of the file. The status bar will be highlighting “Approved/Rejected,” and will note if the file is 

pending approval. Approve and Reject buttons display in the File Status box. 

 

 

 

 

 

 

 

 

 

 

 

5. A list of each issue item contained in the file will display below the File Status box. Their status will 

display as “New Issuance Item.” The client user can review the entries to determine if the file should be 

approved or rejected. In addition, the client user can delete the file prior to and after approval by clicking 

the Delete button at the bottom of the screen. 
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6. If the file is to be approved, click the Approve Button. Once the file is approved, the file status displays 

that the file processing is complete. 

 

 

 

a. After the approval is complete, the issue items will display the status “Available for Matching.” The 

Delete button will still be available to delete a file after approval. 
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b. Returning to the Issuance Files Status page, the file will now display a status of “Client Approved.” 

 

 

 

7. If the file is to be rejected, click the Reject Button. 

 

a.  Once the file is rejected, the file status displays that the file has been rejected by [client username]. 

The individual issue items will no longer display in the issuance file status. 

 

 

8. Returning to the Issuance File Status page, the file will now display a status of “Client Rejected.” 
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I.  Issue Warehouse 
 

PRO-CHEX provides FI and Clients with the visibility to see the status of all issued items. Authorized Client 

users can modify items in the Issue Warehouse. Clients can use the Issue Warehouse to search for issued 

items for a Client or specific account using one of the many filtering options available. 

 

 

 

 

 

 

1. Within the PRO-CHEX module, click View > Issue Warehouse. 

 

 

 

 

 

 

2. The Issue Warehouse page appears. 

 

 

 

NOTE: 

➢ The View Issuance Status user privilege must be enabled. 
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3. To filter the date range of items shown, click on the Date Range drop-down 

 

 

4. To narrow the search results, click Filters and a window containing additional search criteria will appear. 

 

 

 

Account Type an account name or the last 4 digits of the account number. 

Serial Number Type the item serial number for a specific issued item. 

Date Range 
Filter Type 

Issue Date: If selected, issue items will be filtered by the issue date rather than the 
load date. 
 
Load Date: If selected, issue items will be filtered by the load date rather than the 
issue date. 

Min Amount The minimum dollar amount. 

Max Amount The maximum dollar amount. 

Serial Number Range Min Serial Num Type the minimum serial number in the range 

Max Serial Num Type the maximum serial number in the range. 
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Issue Type Issued The check has been issued for payment. 

Voided The check has been voided by maker. 

Stopped The check has a stop payment placed on it. 

Match Status Paid There was a presented item for the issued item, and it has been 
paid. 

Returned There was a presented item for the issued item, and it has been 
returned. 

Outstanding There has been no presented item for the issued item, it remains 
outstanding for 180 days as a default unless specified otherwise 
by your financial institution. 

 

 

5. Once search criteria are selected, click Apply to narrow your search results. 

 

 

6. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, the 

results will be displayed on multiple pages. Use the navigation buttons at the top of the search results to 

review all results.  

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: 

➢ Issuance data is available for 1 year as the default setting, but this can be 

configured differently by the FI.  

➢ If Additional Issue Fields are being used, a section to filter by that data will display. 
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Item ID 
The ID number associated with the specific file once an issuance file is processed and 
committed to the database. 

Account Number Displays the Account Number for the item. 

Serial Number Displays the issued item serial number. 

 

 

 

 

 

 

 

 

Payee Name Displays the name of the payee for the item. 

Issue Type Issued The check has been issued for payment. 

Voided The check has been voided by maker. 

Stopped The check has a stop payment placed on it. 

Match Status Paid There was a presented item for the issued item, and it has been paid. 

Returned There was a presented item for the issued item, and it has been 
returned. 

Outstanding There has been no presented item for the issued item, it remains 
outstanding. 
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Amount Displays the dollar amount for the issued item. 

Load Date/Time Date and time the item was loaded. 

Issuance Date The date of the issued item. 

Update Click the pencil icon to update item’s Amount, Status or Issuance Date. 

 

 

 

7. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The 

information shown in this drop-down is an audit history of all the activity that has occurred on the issue 

item. 

 

Status Issued The check has been issued for payment. 

Voided The check has been voided by maker. 

Stopped The check has a stop payment placed on it. 

Amount Displays the dollar amount for the issued item. 

Issue Date The date of the issued item. 

Updated By The user who updated the issue item. 

Updated Date/Time The date and time this issued item was updated. 
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8. Modifying Issue Items. 

 

a. Issue items can be modified by users with a Load Issue File or Manual Issue Entry privilege. Issue 

items can only be modified if the match status = outstanding. Click the edit pencil button under the 

Update column to update the issued item. 

 

 

9. The Update Issue Item pop-up window appears.  

 

 

Serial Number Check serial number. This cannot be updated on an existing issued item. 

Amount Amount of the issued item. The amount can be updated. 

Payee Name The name of the Payee associated with the specific issued item. The payee name can be 
updated. 

Status Issued The check has been issued. 

Voided The check has been voided by the maker. 

Stopped The check has a stop payment by the maker. 
 
It is important to note that if the FI has disabled stop payments 
in their configuration, Stopped may not be an option in the 
drop-down menu on this pop-up screen. 

Issuance Date The date of the issued item. The issuance date can be updated. 

 

10. Click Save.  
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J.  Item Lookup 
 

PRO-CHEX provides Clients with the ability to look up all recorded data on individual issued items with the 

Item Lookup feature. 

 

1. Within the PRO-CHEX module, click View > Item Lookup. 

 

 

 

 

2. The Item Lookup page appears. All fields are mandatory. 

 

 

Account Select the Account drop-down to display a list of the Client’s Accounts. 

Serial Number Enter the serial number of the item. 

 

 

 

3. Once search criteria are selected, click Apply to complete the item lookup. 
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4. Search results for the item will be displayed. Within this screen, the lifecycle of the issued item will be 

displayed. 
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K.  Other Options Prior to Item Presentment 
 
If a Client needs to make changes to an item prior to item presentment, there are three options for doing so 

within PRO-CHEX. Examples of changes that would fall under this category would be when items originally 

issued are updated to Voided or Stopped status, or to overwrite existing item information such as changes in 

amount and/or payee. It is important to note that if the FI has disabled stop payments, it will affect 

whether a client user can perform these functions in some instances. Please see Subsection B. 

Status Values within this Section for more information. 

 

1. Modifying Issue Items 

 

Issue items can be modified in the Issue Warehouse. Please refer to previous Subsection H. Issue 

Warehouse, for more information. 

 

 

2. Manual Re-Entry 

 

To change individual items previously submitted, a Client user can overwrite the previous item as follows: 

 

 

a. Within the PRO-CHEX Module, click Perform > Manual Issue Entry. 

 

 

 

 

 

 

 

 

b. The Manual Issuance File Entry page appears. For definitions of the fields available on this screen, 

please refer to Subsection C of the current Section.  
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c. Create a Manual Entry for the item to be changed. The serial number must match the previously 

submitted item. Fill out all fields, updating the fields that need to be overwritten with the correct 

information.   

 

d. When all pertinent manual issuance files have been re-entered, click Save button. 

 

 

 

e. The Manual Issuance File detail page appears. For definitions of the fields shown on this screen, 

please refer to Subsection C of the current Section. 

 

 

 

3. File Reloads 

 

To change multiple items that were previously submitted, a Client can use the Issue File Load function to 

reload and overwrite previous items in an Issue File.  

 

a. Once you have prepared your Issue File with all items that need to be overwritten, including the 

corrected information in the appropriate fields, upload the Issue File. Refer to Subsection F. 

Loading Issue Files, for more information. 
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4. Prior to item presentment, these changed/overwritten items can be seen in the Issue Warehouse (please 

refer to Subsection I within this Section for information on how to access the Issue Warehouse). 

Once within the Issue Warehouse screen, click the arrow (>) next to the Client Code to view more useful 

detail on each issued item. The information shown in this drop-down is an audit history of all the activity 

that has occurred on the issue item.  

 

As you can see in the figure below, there are three issue items that have been updated/changed. The 

updates/changes from the most recent entries will overwrite the previously loaded issue item.  
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L. Other Options After Item Presentment 
 

1. Pay & Issue 

 

Single Pay & Issue is an Enterprise feature which allows a client to allow the system to create an 

issue item they failed to send in. This is used for balancing.  

 

2. Mass Pay & Issue 

 

This feature provides a way to handle system creation of multiple issue items instead of the user 

having to click Pay & Issue for each individual issue item if the Client failed to send an entire file 

and it resulted in a lot of no issue exceptions, In addition, it provides a mass pay decision, instead 

of addressing them one at a time. 

 

Please refer to Section VI, Managing Check Presentment, for more information. 
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V. EXCEPTION IDENTIFICATION 
 

 

PRO-CHEX is configured to identify exceptions on issue items in a specific order. Once the first exception is 

triggered on an issue item, the system does not evaluate the item further. If an item is flagged with an 

exception and is deferred to the Client user for decision, it must be noted that further analysis will not be 

performed. Client users should be conscious when paying an exception that other validations may not have 

been performed, so they should examine the item.  

Listed below are the possible Exceptions and the order in which they are flagged by PRO-CHEX. It is 

important to note that the Exception Code and Reason below can be customized by financial institution so the 

example below may vary slightly from exception codes or reasons that appear in the Client interface. 

 

Exception 
Order 

Exception Code Reason 

1 Issuance not found Check presented where no issue item is found to match against. 

2 Issuance already used Check presented with a serial number previously presented. 

3 Issuance voided Check presented with a serial number of an issue item marked with a 
void status. 

4 Issuance stopped Check presented with a serial number of an issue item marked with a 
stop status. 

5 Issuance amount mismatch Check presented where amount of check differs from issue amount. 

6 Amount over limit Transaction amount is over the limit. 

7 Issuance date in future Check presented with a date that is before the issuance date on the 
issued item. 

8 Issuance stale dated Check presented with a date that exceeds the specified number of 
stale days for the account. 

9 Issuance payee mismatch Check presented where payee name differs from issue payee name. 

10 Exception reason missing This message will only appear to customers of FI’s that are in FI or 
Hybrid Matching mode. This exception reason is only used if the 
reason that is coming into PRO-CHEX has not been mapped in PRO-
CHEX. 
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VI. MANAGING CHECK PRESENTMENT 
 

 

The primary objective of PRO-CHEX is to give users the opportunity to make pay and/or return decisions on 

checks presented for payment on accounts enrolled for the service. The decision function is performed in the 

Transaction History screen. 

 

A.  Transaction History 
 

 

PRO-CHEX provides a function for Clients to search and view the status of checks presented on 

enrolled accounts, and to make decisions on presented items. Client users can use Transaction 

History to search for presented check items for a specific account using one of the many filtering 

options available. It is important to note that the default filter setting is Exceptions Only. Additional 

transactions may be available to view and decision (such as reverse positive pay items); however, 

this will not be displayed unless the Exception filters option is set to Show All Transactions. 

 

  

NOTE: 

➢ Transactions are stored for 12 months. 

➢ The Transaction History user privilege must be enabled to access this screen. 

➢ If the user has been granted the Change Status user privilege and the transaction is 

available to decision, the Pay and Return buttons will be available for use. 

➢ Transactions that will be paid will have green shading as a background. 

➢ Transactions that will be returned will have yellow shading as a background. 

➢ Transaction status cannot be changed after the EOD cut-off time. 
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1. View Transaction History 

 

a. Within the PRO-CHEX module, click View > Transaction History. The Transaction History page will 

display all current day transactions for all accounts to which the user has access. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

Transaction ID Unique ID assigned by the PRO-CHEX system when transactions are loaded. 

Account Number Account number the check was presented against. 

Serial Number The check number presented for payment. 

Credit This column will display if deposit information has been entered into the system. 

Debit This column displays checks. 

Current Status Pay Pay-System The system is set to default pay this check. 

Pay-FI The check was paid by the FI. 

Pay-User The check was paid by the Client User. 
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Return Return-System The system is set to default return this check. 

Return-FI The check was returned by the FI. 

Return-User The check was returned by the Client User. 

Date Date the check was presented for payment or loaded to PRO-CHEX. 

Change Status If the user has been granted the Change Status user privilege and the transaction is 
eligible for a decision, a Pay or Return button will appear for use. If the transaction is 
not eligible for a decision, the button will display as ineligible.  

Exception If the transaction is an exception, an exception identifier will appear in this column. 

 

 

b. To filter the date range of items shown, click on the Date Range drop-down. 
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c. To narrow the search results, click Filters and a window containing additional search criteria will 

appear. 

 

 

 

 

 

 

 

 

 

 

 

Account Type an account name or the last 4 digits of the account number into the field to view transactions 
for one specific account or select an account from the drop-down menu. 

Min Amount Type the minimum check amount into the field. 

Max Amount Type the maximum check amount into the field. 

Serial Number Type the check serial number for a single transaction. A serial number range can also be defined 
by entering the minimum and maximum serial number. 

Exceptions The user may select from the drop-down to filter by one of the following: 
 

➢ Exceptions Only 
➢ No Exceptions 

 
The default will be set to “Show All Transactions”; however, the user can click the “Default” 
checkbox to select a different option to be the default for future filtering. 

Items Defaults to Any Items. Select the drop-down to select one of the following: 
 

➢ Any Items: This includes all items, including client pay and adjust items. 
➢ Adjusted Items: Checks that were paid by a client user and either the amount and/or serial 

number was adjusted. 

Transaction  
Status 

Pay Pay-System The system is set to default pay this check. If a user takes no action 
before EOD, the check will pay. 

Pay-FI The check was paid by the FI. 

Pay-User A user changed the transaction status from a Return to a Pay status. 
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Return Return-System The system is set to default return this check. If the user takes no 
action before EOD, the check will be returned. 

Return-FI The check was returned by the FI. 

Return-User A user changed the transaction status from a Pay to a Return status. 

 

 

 

d. Once search criteria are selected, click Apply to narrow your search results. 

 

 

e. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items, 

the results will be displayed on multiple pages. Use the navigation buttons at the top of the search 

results to review all results. 

 

 

  

  

  

  

  

  

  



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 85 of 159 

 

f. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The 

information shown in this drop-down is an audit history of all the activity that has occurred on the 

issue item. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Positive Payee Type This indicates the type of positive pay that the account is set for:  
Standard, Reverse and Payee are the different types that could display here. 

Issuance Payee Name Name of payee submitted with the transaction presented for payment. 

Issuance Serial Number Serial number on the issued item uploaded by the client. 

Issuance Amount Amount on the issued item uploaded by the client. 

Issuance Date Date the issued item uploaded by the client. 

Original Serial Number Serial number submitted with the transaction presented for payment. 

Original Amount Amount submitted with the transaction presented for payment. This number may be 
different than what is displayed in the top line. For instance, if an item was adjusted in 
pre-scrub by the FI or if the FI is allowing Clients to adjust. 
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Return Date Date the item was returned. 

Payment Date Date listed within the transaction file. 

Return Reason Reason for return. 

Loaded Exception 
Reason 

This user documentation displays the standard exception reason labels; however, each 
FI can customize these during implementation so what is seen in the documentation may 
differ from what the User may see in the service if their FI has customized the labels.  
 
Please refer to Section V. Exception Identification to view a list of all standard 
exception labels. 

Payee Match Score Payee scoring is addressed in the account configuration screen. The score displayed 
here is the score that was assigned by the payee analysis engine when the payee name 
on the check was compared to the payee name provided on the issue item. 

 

2. Change Transaction Status 

 

a. If the user has been granted the Change Status user privilege and the transaction is eligible for a 

decision, a Pay or Return button will appear for use. If the transaction is not eligible for a decision, the 

button will display as ineligible. 

 

3. Change Status – Pay 

 

a. If the Current Status on an issued item is set to Return, the Client can opt to change the status to Pay 

if the Client determines the check should be paid.  

 

b. Click the Pay button under the Change Status column. 

 

 

 

The Change Status button will then change to Return, and the Current Status column will update to 

“Pay-User.” 

 

4. Change Status – Return 

 

a. If the Current Status on an issued item is set to Pay, the Client can opt to change the status to Return 

if the Client determines the check should not be paid. 

 

b. Click the Return button under the Change Status column. 
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c. Check Return Reason pop-up window appears. Select the appropriate reason for the Check Return. 

Please note that the list of return reasons displayed are the system default, but may vary depending 

on the way the financial institution defines them. 

 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Amount Incorrect The dollar amount is incorrect. 

Duplicate  This item has already been presented. 

Fraudulent Fraudulent item. 

Prior Stopped This item has a stop payment placed on it. 

Prior Void The item has been previously voided. 

Refer to Maker Refer to the maker of the check. 

Serial # Incorrect The serial number on the item is incorrect. 

Signature Irregular The signature does not match. 

Signature Missing The item is missing a signature. 

Stale Date The presented item has a date greater than the number of stale days allowed on the 
corresponding issued item. 

Suspect Item –  
Review Required 

The item is suspicious and possibly fraud – please review further. 
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d. Click Save. 

 

  

  

  

  

 

 

 

e. The Change Status button will then change to Pay, and the Current Status column will update to 

Return-User.” 

 

 

 

 

 

B.  Optional Actions 
 

1. Confirm Paying Exceptions (May or may not be implemented by the FI) 

 

a. When the first exception is triggered on a presented item, additional validations are not performed. If 

the system detects a user pay decision on a check that additional validations were not performed 

(such as payee name analysis which is the last validation to occur), an image of the check will be 

presented to allow the user to visually inspect the check. The user must click the confirm button to 

finalize the pay decision. 

 

b. If the user decides to pay an item that is set to return, they will be presented with a pop-up window to 

confirm that this is the action they wish to take. The window will display an image of the check and 

other details for the user to review before confirming that they want to pay the item. 
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i. Click Pay to pay a check. 

 

 

 

1) A pop-up window with check information will display for the user’s review. 

 

 

2) Once the user has reviewed the information presented, they can decide to Confirm so that the 

check will be paid or to Cancel so that the check will be returned. 

 

2. Pay & Issue 

 

a. This Enterprise feature must be enabled by the financial institution and the user must have the 

manual issue entry or load issue file user privilege. If an exception is triggered because no issue item 

exists and the user pays the check, the user will be presented with a link allowing them to tell the 

system to create a matching issue item. 
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b. If Client Pay & Issue is enabled, the expanded view on the item will display an Add Issue button. Click 

the button to proceed. 

 

i. Add Issue Item pop-up displays. The Serial Number, Amount, and Status are all locked from 

editing. Click in the Payee Name to enter a payee name, or the Issuance Date field to select the 

date of the issued item. 

 

 

1) Click Save. 

 

  

  

  

 

 

3. Mass Pay & Issue 

 

a. This Enterprise feature must be enabled by the financial institution and the user must have the 

manual issue entry or load issue file user privilege. Clients on standard or payee positive pay should 

ALWAYS enter or load issue items prior to distributing checks to avoid denial of payment at the teller 

line. However, should a client fail to enter or load issue items and a large number of no issue 

exceptions occur as a result, this feature allows the user to have issue items systematically created 

for each item without clicking on each exception item individually and pay all items at once instead of 

individually. 
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b. If Mass Pay & Issue is enabled, a button will display at the top of the Transaction History screen: 

“Mass Pay and Issue.” 

 

 

 

 

 

 

 

c. The Mass Pay & Issue page appears. A list of issue items will list on the page, with checkboxes for 

each issue item. 

 

 

d. Individual issue items can be clicked for Pay and Issue. Once all issue items are selected, click “Pay 

and Issue Selected” button at the bottom left of the screen. 

 

 

 

 

 

e. To approve all issue items to Pay and Issue, click “Pay & Issue All [number]” button. It is important to 

note that the Mass Pay & Issue page displays 25 issue items per page. The “Pay & Issue All 

[number]” button will Pay & Issue all the available issue items on all pages. The button will display the 

total number of issue items available. 
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f. A “Confirm Mass Pay & Issue” pop-up window appears. Click Cancel to return to the Mass Pay & 

Issue screen or Confirm to continue. 

 

  

  

  

  

  

  

  

  

 

g. Success message appears.  

 

  

  

  

 

 

It is important to note that the Mass Pay & Issue button is also available within the Consolidated 

Transaction History screen. Please refer to the FPHQ Client User Guide for more information. 

 

4. Pay & Adjust 

 

a. This Enterprise feature must be enabled by the financial institution. The FI may choose to allow users 

to adjust a serial number from the value presented to a new value and/or the amount from the amount 

presented to a new value. 

 

 

b. If Client Pay & Adjust is enabled, a link will display under the Pay button: “Adjust?” 
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i. Click Adjust. 

 

1) The Adjust pop-up screen displays. The fields available in Adjust are contingent upon what 

the FI has enabled. In this example, the Adjust screen includes check amount and serial 

number. Enter the correct serial number and/or amount. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) Click Save. The Transaction History page displays the adjusted serial number and/or adjusted 

amount. 

 

 

 

3) When the serial number is changed using Pay & Adjust, any issuance items previously 

matched and used by this transaction will be marked as “Available for Matching”, releasing 

the issuance for matching by future transactions.  In addition, issuance matching will be 

performed using the new serial number and if any issuance is found it will be marked as 

“Used in Matching.”  
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VII. REPORTS 
 

 

 

 

 

 

 

 

 

 

A.  Issue Item Status Report 
 

  

  

  

  

  

  

 

1. Within the PRO-CHEX Module, click Reports > Issue Item Status. 

 

 

 

 

 

 

  

NOTE: 

➢ Reports are available for one (1) year. 

NOTE: 

➢ The Issue Item Status Report user privilege must be enabled. 
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2. The Issue Item Status Report page appears. The page will default to Outstanding items but can be 

changed to Paid items or Returned items. 

 

 

Issuance Status Outstanding Any items that have not been matched and decisioned yet. 

Paid Any items that have been matched and paid. 

Returned Any items that have been matched and returned. 

Stops/Voids Any items that have a stopped/voided status. 

Start Date The start date is only applicable when filtering by Paid or Returned Issuance Status. 

End Date The end date will default to the current date. 

Summary Information 
Only 

Will show summary, rather than detailed, information on the displayed data. 

Account To further narrow down the results the report can be filtered by a specific account. 

 

3. Once search criteria are selected, click Apply to narrow your search results. 

 

 

4. Search results are displayed in pages of 25 items. If the search contains more than 25 transactions, the 

results will be displayed on multiple pages. Use the navigation buttons at the top of the search results to 

review all results. 

 

  

  

  

  

  

  

  

 

 



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 96 of 159 

 

5. The Issue Item Status report will populate below the search window. 

 

 

Account Number Displays the masked account number. 

Serial Number Displays the serial number for the item. 

Payee Name Displays the payee name, if applicable. 

Amount Displays the amount of the issuance item. 

Issuance Date Displays the date of the issuance item. 

Payment Date Displays the payment date of the item. 

Return Date Displays the return date of the item. 
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6. If the Summary Information Only checkbox was selected, the Issue Item Status report will populate with 

summary information as shown in the graphic below. 

 

 

Account Number Displays the masked account number. 

Account Name Displays the name of the account. 

Check Status Displays the status of the issued items. 

Total Items Displays the total amount of items with a particular check status for a specific 
account. 

Total Dollar Amount Displays the total dollar amount of all items in the row. 

Grand Total Displays the grand total dollar amount of all items displayed in the rows above. 
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B.  Scheduled Reports 
 

The Scheduled Reports is an Enterprise level feature in PRO-CHEX designed to provide information related 

to outstanding issue items and paid items on a frequency. Scheduled reports can be configured to be 

delivered to the financial institution for forward deliver to the Client and/or they can be obtained through the 

Client portal. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Based on the report templates configured for each account, a client user can also choose to generate interim 

reports. Interim reports provide the information between the last frequency the report was generated through 

the current date the interim report is being generated. 

1. To schedule a new report, click the Generate Interim Reports button.  
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2. The Interim Reports window will appear.  

 

 

 

3. Select the appropriate account from the Account drop-down menu. 
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4. Select the desired template from the Template drop-down menu. Template options will be limited to 

scheduled report templates configured on the selected account and will vary based on what type of 

reports the client and the FI have agreed upon. 

 

 

 

5. Select desired start and end dates for interim reports. Once all fields have been selected, click Generate 

Report button. If the user is generating multiple reports, the user can click the Generate Another 

checkbox before clicking the Generate Reports button. 
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6. If the user is generating more reports, a success message will appear at the bottom of the Interim 

Reports pop-up window, and the window will stay open to add information for another Interim Report. 

Once the information for the last Interim Reports has been entered, unselect the Generate Another 

checkbox and click Generate Reports to continue. 

 

 

 

7. The Interim Reports pop-up screen will automatically close, and the Scheduled Reports screen will 

display. The Interim Reports requested by the user appear on the Scheduled Reports list. 
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C. Reconciliation Reports and Reconciliation Periods 
 

 

  

  

  

  

  

 

PRO-CHEX has added the Active Reconcilement function, an Enterprise feature, designed for a user to compare 

the actions taken in PRO-CHEX against a company’s internal accounting system and bank account/statement. 

Reconciling accounts is a standard and good business practice. It is required to ensure company accounting 

records and bank account activity align and which issued checks have been paid and which remain outstanding. 

Since PRO-CHEX is the system of record for housing issued items, performing exception identification and 

accepting pay/return decisions from the company, PRO-CHEX records should align with the company’s internal 

accounting records and the account activity shown in online banking or bank statements. 

Currently, the Account Reconcilement function is performed only by the FI, if enabled. The client user, however, 

can access Reconciliation reports or view past and present Reconciliation Period activity. 

 

1. Reconciliation Reports 

 

 

a. Within the PRO-CHEX Module, click Reports > Reconciliation. 

 

 

 

 

NOTE: 

➢ The Issue Item Status Report user privilege must be enabled. 
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b. The Reconciliation Reports page displays.  

 

 

 

 

c. To filter the date range of the reports shown, click on the Date Range drop-down. 
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d. To narrow the search results, click Filters and a window containing additional search criteria will 

appear. The Reconciliation Reports list can be filtered by Report Status only.  

 

 

 

 

 

e. Once search criteria are selected, click Apply to narrow your search results. 

 

 

f. Reconciliation Report items are displayed in pages of 25 items. If the report contains more than 25 

items, the results will be displayed on multiple pages. Use the navigation buttons at the top of the 

report results to view all results. 

 

 

  

  

  

  

 

 

 

 

Report Status Generated This means that the report was created successfully and that it 
contains data based on the chosen report template. 

Downloaded Downloaded means that the report has been downloaded by a 
user. 

Failed Failed means that the report did not generate properly. 

Empty Empty means that the report ran, but there was no data to pull into 
the report for the given time period. 
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g. Click the arrow (>) button next to the Report name to view more useful detail on each Reconciliation 

Report. The information shown in this drop-down is an audit history of all the activity that has 

occurred on the Reconciliation Report. 

 

 

 

 

Report Name The name of the report file. 

Report Status Refer to paragraph d. within this section for Report Status definitions. 

Request Type The Request Type indicates whether the report was automatically generated by the 
system as part of the schedule setup for the report to run on. 

Download Report Button Click to download a copy of the Report in the designated format. 

Generated Date Date the report was generated. 

Downloaded Date Date the report was downloaded. 

Requested Date Date and Time report was requested. 

Requested By User or system who requested the report. 



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 106 of 159 

 

2. Viewing Reconciliation Periods: 

 

a. Within the PRO-CHEX Module, click View > Reconciliation Periods. 

 

 

 

b. The Reconciliation Report Account Page displays a list of the accounts that have been provisioned 

with Account Reconciliation. The user can search by account number or name if a long list of 

accounts is displayed. Click the Select button on the appropriate account to proceed. 

 

 

 

c. From the Reconciliation Report page for the specific account, the user can select to view any closed 

or active reconciliation period that is displayed in the list. Click Change Account to return to the list of 

Accounts or click the Select button to choose a reconciliation period. 
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d. The Reconciliation statement for the chosen period will display. An example of the screen view is 

provided below. Depending on the type of reconciliation the account is set for, the user may see tabs 

at the top of the screen to view Check reconciliation, Deposit reconciliation and/or Statement 

reconciliation. 

 

For more information about the Active Reconciliation function, please speak to your Financial 

Institution. 
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VIII. PAYEE POSITIVE PAY TIPS & BEST PRACTICES 
 

 

For client users to have the best user experience possible, we have outlined some best practices to help 

make the onboarding process more efficient. 

 

 

 

 

 

A.  Payee Name Comparison: “Scoring” 
 

PRO-CHEX payee name scoring is robust and can reasonably handle a variety of check styles, fonts, and 

even hand-written names on a payee line with fewer exceptions than most systems in the market. However, if 

your organization would like to achieve optimal scoring results for payee positive pay, we recommend you 

follow as many of the best practices outlined in the sections below. 

 

Payee name scoring relies upon the customer using the best possible check design and format. However, 

when customers do not follow best practices and there are problems with analyzing the check images for 

payee information, the FI does have options to allow for alternative actions, such as scrubbing exceptions 

and payee override after visually inspecting the check.  

 

B.  Ideal Check Formatting 
 

Customers will find the most success following these suggestions in their check designs and format. 

 

• Paper weight should be 24” MICRBond (to ensure better image quality when physically captured with 

reader). 

 

• Use check stock with no backgrounds or lighter colored backgrounds and no logos or marks in the 

payee field. 

 

• Minimum 200 dpi resolution required; higher resolution preferred. 

 

• Checks should be fixed width (fixed spacing) 10-point font or higher. 

 

• Sans Serif fonts are preferred (no bold). 
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• “PAY TO THE ORDER OF” should not be italicized or underlined and must be printed horizontally at 

the same level to the left of the payee name. 

 

• Payee name should be a maximum of 500 characters and left aligned. 

 

• The payee name should be surrounded by an area of white space. 

 

• Payee name should not be underlined. 

 

Below are examples of checks that have been formatted to ensure best results: 
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C.  Common Check Formatting Problems 
 

Following are some examples of check formats which cause processing errors and issues with payee 

scoring. 

 

Bad Scans & Poor Image Quality 

Poor image quality can interfere with scans.  

 

It appears the check paper was inserted into the printer improperly, causing the payee name information to print in a blurred/slanted 

condition and therefore cause issues with scanning. [Payor name, Payee name and bank name partially removed for confidentiality] 
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Poor Image Quality.  

 

Poor image quality. Check fields are in non-serif fonts. 

 

 

 

 

 

 

Incorrect Formatting 

Acme Commercial Bank 
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Incorrect formatting and placement of check elements cause problems with analyzing check images for 

payee information. This example shows several formatting/positioning errors that are not considered best 

practices: 

 

Background is too dark (A) 

San Serif Fonts are preferred. Labels here are in block, non-serif formats (B) 

“Pay to the Order of” should be printed level and to the left of the Payee Name line (C) 

Payee Name should not be underlined (D) 

Dollar Amount is positioned above the Payee section and using a script font which will cause issues in scanning (E) 

 

 

“Pay to the Order of” should be printed level and to the left of the Payee Name line. 

 

 

 

D.  Multiple Payee Handling 
 

 

PRO-CHEX has the ability to support customers with multiple payee names on issued items. PRO-CHEX can 

score multiple names on a check against information provided in the issuance file. Multiple payees can be 

listed on a single line, or on two separate lines on the check. Examples of correct and incorrect formatting are 

shown below. 

D 

B 

C 

A 

E 

Acme Commercial Bank 
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1. This section is designed to explain how to handle multiple payee names that will appear on two separate 

lines of the check.  

 

a. Multiple Payee Handling setup in Issue Templates.  

 

i. The Multi-Line Payee Name Separator field is included in the Issue Template creation screen 

that allows for recognition and recording of multiple payees on a check.  
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ii. This feature allows the FI or Client user to enter a character into the field that can be used to 

separate Multiple Payee Names that are on separate lines of an issued item. Currently, the 

system restricts the allowed characters to the following:  ;  |  ,  -  _  /  . The user must be 

aware that using a separator character that appears elsewhere in the payee name or might 

conflict with the file itself can cause issues. Examples of scenarios where problems might arise 

are listed below. 

 

Within a Comma Separated file (.csv), different data fields are separated by a comma. Therefore, 

a comma cannot be used in the data field itself, or the .csv will read the comma as a separator 

before the next field. Therefore, listing two payees for an item in this way: “Elain Archeron,Nesta 

Archeron” will cause issues reading the .csv file. In this scenario, the user should select a multi-

line payee name separator character that will not cause an issue, such as a semicolon. “Elain 

Archeron;Nesta Archeron” in the Payee Name field of the .csv file will process correctly. 

 

If the user selects a separator character that would ever appear in a payee name field, such as a 

dash (-), the system would then separate the data before and after the character as separate 

payees. For instance, if the user has selected a dash (-) as the Multi-Line Payee Name 

Separator, and a common payee used is “In-and-Out Burger”, the system will flag this as having 

multiple payees. In this case, the user should select a multi-line payee name separator that will 

not cause such issues, such as a pipe (|) or a semicolon for cases of multiple payee names. 

 

b. Multiple Payee Handling in Manual Issue Entry. 

 

i. When the Client user performs Manual Issue Entry, the Payee Name field supports up to four 

Payees. When in the Manual Issue Entry screen, the names should be listed as shown below. An 

Enter (carriage return) must be used to input the second, third or fourth payee on separate lines 

in the field for it to be distinguished as different payees. 
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If the multiple payees are listed on a single line of the check, putting the names on separate lines 

is not applicable. 

 

 

 

ii. It is important to note that the Payee Name field currently supports 500 characters in total. 

This character limit includes the carriage returns separating multiple payees. The 500-

character limit is for the entire field, and not per payee. 

 

Please refer to Section IV, Subsection C, for more detailed information about Manual Issue 

Entry. 

 

 

c. Multiple Payee Handling when Loading Issue Files. 

 

i. When the Client user loads issue files to the system, the loaded file is processed with an Issue 

Template set up within PRO-CHEX. The Issue Template allows for selection of a Multi-Line 

Payee Separator, a character chosen to separate the names of multiple payees in the issue file.  

 

ii. If multiple payees are listed on a single line of a check, no action needs to be taken. 

 

iii. If multiple payees are listed on two or more separate lines on a check, the multiple payee 

separator character (which should match the one designated in the template), must be used 

between each name. 

 

Please refer to Section IV, Subsection F, for more detailed information about Loading Issue 

Files. 
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d. Things to Remember: Multiple Payee Name Separators. 

 

To recap the information covered above, remember: 

 

i. The Multi-Line Payee Name Separator character designated in the Issue Template must match 

what is used in the Issue Files loaded to the system. The system will recognize that character and 

when encountered in an Issue File, will record the data appearing after that character as a 

separate payee. 

 

ii. The allowable characters are:  ;  |  ,  -  _  /  . 
 

iii. Some characters may cause problems when used as a separator. Do not use a character as a 

separator if that character will ever be present in a Payee Name, or is a character used in a 

specific file type (i.e., Comma Separated files).  

 

iv. Payee Name Separators are only necessary when payee names are listed on two or more 

separate lines of a check. 
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IX. PREFERENCES 
 

 

A.  Preferences 
 

1. From within the Dashboard or PRO-CHEX Module, click User’s Name > Preferences. 

 

 

 

 

 

 

 

 

 

 

2. The Preferences page appears.   

 

3. Default Module gives the User the ability to choose the default landing page. 
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4. Default PRO-CHEX Page allows the user to select the default landing page within PRO-CHEX. 

 

 

 

5. Default Dashboard Page allows the user to select the default landing page within the Client Dashboard. 

 

 

6. Once any preferences have been selected, click Save to update the settings. 
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APPENDIX A – MESSAGE ALERTS 
 

 

Service 
Module 

Alert Type Description Recipient 

PRO-CHEX CP Send Issuance Load Alert Failure If FI is sending issue files to ACH Alert 
on behalf of Clients, this alert is sent to 
users with the system alerts flag enabled 
when an issue file fails to load properly. 
If the FI has enabled this feature for 
Clients, this alert will be sent to Clients 
with the issue load alerts privilege 
enabled when an issue file loaded 
through the Client portal has issues that 
prevent it from loading successfully. 

FI & 
Client 

 CP Send Issuance Load Alert 
Success FI 

If FI is sending issue files to ACH Alert 
on behalf of Clients, this alert is sent to 
users with the system alerts flag enabled 
when an issue file loads properly. If the 
FI has enabled this feature for Clients, 
this alert will be sent to Clients with the 
issue load alerts privilege enabled when 
an issue file loaded through the Client 
portal loads successfully. 

FI & 
Client 

 CP Acct All An alert per account sent to users for 
exceptions and any matched items. 

Client 

 CP Acct Exceptions An alert per account when one or more 
exceptions exist that require a decision. 

Client 

 CP EOD Reminder This alert will be sent to Client users with 
the change transaction status user 
privilege if exceptions exist and a user 
with change transaction status has not 
logged into the system at the FI’s 
designated time. This alert option will 
only be available if enabled by the 
financial institution. 
 
If alert method for PROCHEX is set to 
“None” for a Client User, they will not 
receive the EOD reminder alert. 

Client 

 CP TRX All An alert per check transaction. Client 

 CP TRX Exception An alert set per transaction deemed an 
exception by the system. 

Client 
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APPENDIX B – QUICKBOOKS ISSUE FILE EXPORT 
 

 

This guide is meant to aid client users in exporting check file data from QuickBooks. There are two methods 

of exporting the check file data from QuickBooks. Both options are outlined below. These examples are from 

the QuickBooks desktop version. The first option is using a Quick Report from the checking account. The 

second method is using the Check Detail Report, which requires more actions for the user to take.  

 

A.  Exporting from QuickBooks Account Register 
 

1. From QuickBooks, use Ctrl+A to open the account listing from any screen.  

 

2. Click once to select the appropriate account to pull the Check File.  

 

 

 

3. Once the Check Report has been populated, use Ctrl+Q to create a Quick Report from the selected 

account.  
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a. Select the Date drop-down menu to choose a specific date or date range for the transactions to 

display in the report. Based on the range that is selected, check items that can be displayed can be 

for a specific date, a specific quarter, month or even a date range that the user selects. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Click Customize Report button. The Modify Report screen displays. By using the Customize Report 

feature, the user will be able to manage the amount of information contained in the report prior to 

exporting the report to Excel.  The user can select and/or remove items that are not needed in the 

report. 
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c. Click the Filters tab. In the listing of Filters, select Transaction Type. This will allow the user to remove 

the transaction types that are needed for the check file. 
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d. From the Transaction Type drop-down menu, select Multiple Transaction Types. This will allow the 

user to select multiple check types within QuickBooks. For this example, we have used Check and 

Bill Payment. Click OK to confirm the transaction types. 
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e. From the Modify Report screen, select OK to proceed. The requested changes to the report will 

display. 

 

 

f. From the QuickBooks toolbar, click the Excel drop-down menu and select Create New Worksheet. 
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g. The Send Report to Excel pop-up window appears. Select Create New Worksheet > In New 

Worksheet and click the Export button to continue. 

 

 

 

h. Excel will open and the Excel file will populate. Within the Excel file, remove all rows that are blank 

under the column header “Num”. By removing these items from the check file, items that do not have 

a serial number assigned to them will not be uploaded into the PRO-CHEX System. 

 

 

 

 

 

 

 

i. Remove the “Balance” column. This information is not needed for the Check File upload to PRO-

CHEX. 
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j. Select File > Save As and save the workbook. 

 

i. Choose the File Name. 

 

ii. Choose the Format. The file format for this file must be Comma Separated, Excel 97-2003 

Workbook or Excel Workbook. 

 

 

k. Click Save and close the workbook. 
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4. Sign into the ACH Alert Client Portal. 

 

 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 

5. Select the PRO-CHEX Service Module. 

 

 

 

6. From the PRO-CHEX module, select Manage > Issue Templates to create an issue template. This will 

allow the user to map the exported information from QuickBooks so that the file is read correctly when 

uploaded to PRO-CHEX. The user will also be able to save this template for use in future issuance file 

uploads. 
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7. The Issuance File Templates page displays. This page lists the saved Issue File Templates available for 

the Client to use and allows the user to create a new template for use. Select Create New Template. 

 

 

 

 

 

 

 

 

8. The Create New Template screen appears. 



Version 2.1.0 rev 1 
Updated 01/07/2021 Page 131 of 159 

 

9. Creating the Issuance Template to the Exported Information from QuickBooks: 

 

a. Template Name 

 

Create a name for the template using information that will allow the user to easily identify this 

template in the future. For this example, the template name is QuickBooks Export Type 1. 

 

 

 

b. File Type 

 

Select the appropriate file type based on the file type used to save the Excel document. For this 

example, the file type will be Excel Workbook. 

 

 

c. Template Status 

 

The Template Status drop-down menu defaults to Active status. Leave the status as Active. 
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d. Number of Header Rows 

 

Refer to the Excel file that was created. A Header Row will be any row above the check information 

that does not contain actual check information for presentment in the PRO-CHEX Module. For this 

example, the header rows have been highlighted yellow. The number of header rows should be 2 in 

the template. 

 

 

 

e. Number of Footer Rows 

 

Refer to the Excel file that was created. A Footer Row will be any row below the check information 

that does not contain actual check information for presentment in the PRO-CHEX Module. For this 

example, the footer rows have been highlighted yellow. The number of footer rows should be 2 in the 

template. 
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f. Template Level 

 

The default value of Client will be presented and will not allow a different selection to be made. 

 

 

g. Multi-Line Payee Name Separator. 

 

This feature is not currently available for items exported out of QuickBooks. 

 

 

h. File Mapping 

 

i. Serial Number 

 

1. Enter the column number that the check number/serial number is presented in the Excel 

document. For this example, the Num column is highlighted yellow. The column number for 

Num should be 9 in the template. 
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ii. Amount 

 

1. Enter the column number that the amount is presented in the Excel document. Select 

fractional dollars if the dollars and cents are separated by a decimal. If the dollars and cents 

are not separated by a decimal, select whole numbers of cents. For this example, the Amount 

column is highlighted yellow. The column number for Amount should be 17 in the template. 

 

 

 

iii. Status 

 

1. Remove the checkmark from this box. The export from QuickBooks does not contain this 

information. The user can add this information manually if they choose to. If the column is 

added, the box will need to remain checked and the column number will need to be entered 

for the PRO-CHEX system to accurately read it. For this example, the Status field is not being 

used. 

 

 

If the Status box is unchecked, the user should be aware that any issuance loaded with 

negative amounts or a $0 amount will be treated as Void. 
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iv. Account Number 

 

1. The exported information from QuickBooks does not include an account number. Leave the 

box unchecked and the File Column field blank. For this example, the Account Number field is 

left blank. 

 

 

 

 

v. Issuance Date 

 

1. The Issuance Date is located in the “Date” column in the Excel document. The user must 

check the box and enter the column number for the system to read the issuance date 

correctly. For this example, the Date column is highlighted yellow. The column number for 

Issuance Date should be 7 in the template. 
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vi. Payee Name 

 

1. If the Client is set up to use Payee Positive Pay, the user will need to select the box and enter 

the column number for the column labeled “Name” in the Excel report. For this example, the 

Name column is highlighted yellow. The column number for Payee Name should be 11 in the 

template. 

 

 

 

vii. Additional Issue Fields 

 

1. Additional issue fields are available for client use to allow clients to record any additional 

information into an issuance file to be used for historical or reconciliation purposes. In the 

example below, the client has additional issue fields configured: Company Name, Invoice, 

and Address. For the purposes of Export from QuickBooks, the user should disregard these 

fields as they do not apply to the export process. 
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viii. Click the Save button.  A success message appears, and the user will be returned to the 

Issuance Templates page. The new issue template will display in the list of templates. 

 

 

 

B.  Exporting from QuickBook Reports 
 

1. From QuickBooks, select Reports on the Tool Bar. 
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2. Select Banking from the drop-down menu and click Check Detail from the Banking sub-menu. 

 

 

3. The Check Detail Report will display. 
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a. Select the Date drop-down menu to choose a specific date or date range for the check items to 

display in the report. Based on the range that is selected, check items that can be displayed can be 

for a specific date, a specific quarter, month or even a date range that the user selects. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Click Customize Report button. The Modify Report screen displays. 
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c. Select the Filters tab.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

d. In the listing of Filters, select Account from the drop-down menu. 

 

i. Select All Bank Accounts to pull all checks issued from all bank accounts for which the user has 

QuickBooks access. 
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ii. Select a single Bank Account to pull checks issued from a single bank account. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

iii. Under Include Split Detail?, click the button next to “No”. 
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iv. Under Current Filter Choices, select Detail Level, and then click the Remove Selected Filter 

button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

v. Select Transaction Type from the Filter menu. Select Multiple Transaction Types from the 

Transaction Types submenu. 
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vi. From the Select Transaction Type drop-down menu, select the check transactions to appear in 

the Check File. For this example, Check and Bill Payment options were selected. Click OK to 

confirm the transaction types. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

e. From the Modify Report screen, select OK to proceed. The requested changes to the report will 

display. From the QuickBooks toolbar, click the Excel drop-down menu and select Create New 

Worksheet. 
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f. The Send Report to Excel pop-up window appears. Select Create New Worksheet > In New 

Worksheet and click the Export button to continue. 

 

 

g. Excel will open and the Excel file will populate. Within the Excel file, remove all rows that are blank 

under the column headers “Type” and/or “Num”. 
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h. Remove all blank columns. 
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i. Select File > Save As and save the workbook. 

 

i. Choose the File Name. 

 

ii. Choose the Format. The file format for this file must be Comma Separated, Excel 97-2003 

Workbook or Excel Workbook. 

 

 

 

j. After saving, close the Excel workbook. 
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4. Sign into the ACH Alert Client Portal. 

 

 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

 

5. Select the PRO-CHEX Service Module. 

 

 

6. From the PRO-CHEX module, select Manage > Issue Templates to create an issue template. This will 

allow the user to map the exported information from QuickBooks so that the file is read correctly when 

uploaded to PRO-CHEX. The user will also be able to save this template for use in future issuance file 

uploads. 
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7. The Issuance File Templates page displays. This page lists the saved Issue File Templates available for 

the Client to use and allows the user to create a new template for use. Select Create New Template. 

 

 

 

 

 

 

 

 

8. The Create New Template screen appears. 
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9. Creating the Issuance Template to the Exported Information from QuickBooks: 

 

a. Template Name 

 

Create a name for the template using information that will allow the user to easily identify this 

template in the future. For this example, the template name is QuickBooks Export Type 2. 

 

 

 

b. File Type 

 

Select the appropriate file type based on the file type used to save the Excel document. For this 

example, the file type will be Excel Workbook. 

 

 

c. Template Status 

 

The Template Status drop-down menu defaults to Active status. Leave the status as Active. 
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d. Number of Header Rows 

 

Refer to the Excel file that was created. A Header Row will be any row above the check information 

that does not contain actual check information for presentment in the PRO-CHEX Module. For this 

example, the header rows have been highlighted yellow. The number of header rows should be 2 in 

the template. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

e. Number of Footer Rows 

 

Refer to the Excel file that was created. A Footer Row will be any row below the check information 

that does not contain actual check information for presentment in the PRO-CHEX Module. For this 

example, the footer rows have been highlighted yellow. The number of footer rows should be 2 in the 

template. 
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f. Template Level 

 

The default value of Client will be presented and will not allow a different selection to be made. 

 

 

g. Multi-Line Payee Name Separator. 

 

This feature is not currently available for items exported out of QuickBooks. 

 

 

h. File Mapping 

 

i. Serial Number 

 

1. Enter the column number that the check number/serial number is presented in the Excel 

document. For this example, the Num column is highlighted yellow. The column number for 

Amount should be 2 in the template. 
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ii. Amount 

 

1. Enter the column number that the amount is presented in the Excel document. Select 

fractional dollars if the dollars and cents are separated by a decimal. If the dollars and cents 

are not separated by a decimal, select whole numbers of cents. For this example, the Amount 

column is highlighted yellow. The column number for Amount should be 6 in the template. 

 

iii. Status 

 

1. Remove the checkmark from this box. The export from QuickBooks does not contain this 

information. The user can add this information manually if they choose to. If the column is 

added, the box will need to remain checked and the column number will need to be entered 

for the PRO-CHEX system to accurately read it. For this example, the Status field is not being 

used. 

If the Status box is unchecked, the user should be aware that any issuance loaded with 

negative amounts or a $0 amount will be treated as Void.  
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iv. Account Number 

 

1. The exported information from QuickBooks does not include an account number. Leave the 

box unchecked and the File Column field blank. For this example, the Account Number field is 

left blank. 

 

 

 

 

v. Issuance Date 

 

1. The Issuance Date is located in the “Date” column in the Excel document. The user must 

check the box and enter the column number for the system to read the issuance date 

correctly. For this example, the Date column is highlighted yellow. The column number for 

Issuance Date should be 3 in the template. 
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vi. Payee Name 

 

1. If the Client is set up to use Payee Positive Pay, the user will need to select the box and enter 

the column number for the column labeled “Name” in the Excel report. For this example, the 

Name column is highlighted yellow. The column number for Payee Name should be 4 in the 

template. 
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vii. Additional Issue Fields 

 

1. Additional issue fields are available for client use to allow clients to record any additional 

information into an issuance file to be used for historical or reconciliation purposes. In the 

example below, the client has additional issue fields configured: Company Name, Invoice, 

and Address. For the purposes of Export from QuickBooks, the user should disregard these 

fields as they do not apply to the export process. 
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i. Click the Save button.  A success message appears, and the user will be returned to the Issuance 

Templates page. The new issue template will display in the list of templates. 
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C.  Loading the QuickBooks Issue File 
 

1. From the PRO-CHEX Module, select Perform > Issue File Load. 

 

 

 

 

 

 

 

 

2. The Load Check Issuance File page appears. 

 

 

 

3. Select the Template drop-down box to select from a list of existing templates. Select the appropriate 

template. For this example, QuickBooks Export Type 2 will be used. 
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4. The template selected was created without the Account field enabled. A drop-down box will display so 

that the appropriate account can be selected. Select from the list of accounts. For this example, ABC 

Heating – xxxx1555 will be used. 

 

 

5. The file upload interface will appear. Click the Browse button to select the appropriate file or drag and 

drop the file into the box indicated on the interface screen. 
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6. Once the file is selected, it will be displayed in the upload interface. 

 

 

7. Click the Upload button to proceed. Once the file has loaded successfully, the Issuance File Status page 

will display and will be eligible for editing in the Issue Warehouse. 

 

 

 


